





IBM Systems

IBM Power Executive
Installation and User's Guide

Version 1.0



Note
Before using this information and the product it supports, read the information in the "Notices"
Appendix.

First Edition (December 2005)

This edition applies to version 1.0 of IBM Power Executive and to all subsequent releases and modifications until
otherwise indicated in new editions.

© Copyright International Business Machines Corporation 2005. All rights reserved.
US Government Users Restricted Rights — Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.



Contents
Tables . . . . . . . . .. .. ...V

About this user's guide . . . . . . . vii

Who should read this user’s guide . . . . . . vii
Conventions and terminology . . . . . . . . vii
Related information . . N v
How to send your Comments B 4 11
Accessibility. . . . . . . . . . . . . . vii

Chapter 1. Getting started .

Introducing Power Executive .
Power Executive Task Overview .
Power Executive terminology .

Power Executive components.
Power Executive Server.

Power Executive Console .
Power Executive database .

Power Executive task . .
Starting Power Executive for all Chas51s ob]ects
Starting Power Executive for some chassis objects

Power Executive window .

Navigation pane .

Detail pane .

Trend pane . .

Customizing the Power Executlve wmdow .

Refreshing the Power Executive window .
Invoking Power Executive functions

O O 0NN UTUTUT R WWWWN R =,

Chapter 2. Installing Power Executive 11

Requirements. . . . . . . . . . . . . .1
Hardware requirements . . . . . . . . .11
Supported operating systems . . . . . . .11

Preparing to install Power Executive . . . . . .12
Checking all prerequisites . . . . . . . .12
Downloading Power Executive. . . . . . .12

Installing Power Executive on systems running

Windows . . . .12

Installing Power Executlve on systems runnmg

Linux . . . B ¢

Uninstalling Power Executlve on systems running

Windows . . . .14

Uninstalling Power Executlve on systems runnmg

Lnux . . . . . . . . . . . . . . . .14

Chapter 3. Using Power Executive. . . 15

© Copyright IBM Corp. 2005

Monitoring power consumption data. . . . . .15
Displaying details about a group of chassis. . . 15
Displaying summary information about a group
of chassis . . . . 16
Displaying details about an 1nd1v1dual chassns .17
Displaying summary information about an
individual chassis . . . .. .18
Displaying details about md1v1dua1 power
domains . . . P £
Displaying summary 1nformatlon about
individual power domains . . . . 20
Displaying details about individual power ob]ects 21
Setting the derating power factor . . . . . .22

Collecting power consumption data . . . . . .23
Suspending data collection . . . . . . . .23
Resuming data collection. . . . . . . . .23

Managing trend data . . . .
Managing collection of trend data S .24
Creating a custom time interval for the trend
pane. . . L. . 24

Exporting data from Power Executlve .. . . .25
Exporting summary data. . . . . . . . .25
Exporting the power meter . . . . . . . .25
Exporting a trend graph . . . . . . . . .26
Exporting a trend table . . . . . 26

Understanding events that affect Power Executlve 26
Events that cause refresh operations . . . . .27
Events reported on the trend pane. . . . . .28

Chapter 4. Troubleshooting. . . . . . 29

Contacting customer support . . . . . . . .29
Before youcall . . . . . . . . . . . .29
Using the documentation. . . .29
Getting help and information from the World
Wide Web . . . . . B
Software service and support 0

Appendix. Notices. . . . . . . . . . 31
Trademarks . . . . . . . . . . . . . .32

Abbreviations, acronyms, and glossary 33
Abbreviation and acronym list . . . . . . . .33
Glossary . . . . . . . . . . . . . . .33

Index . . . . . . .. ... ... .3

iii



iV IBM Power Executive Installation and User's Guide



Tables

—_

NGk w0

Colors and meanings that are used in trend

graph. . . . . . . . . . . . . . .8
Toolbar icons and their actions . . . . . .9
Power Executive files that can be downloaded 12
Detail information about a group of chassis 15

Summary information about a group of chassis 16
Detail information about an individual chassis 17
Summary information about an individual

chassis . . . . . . . . . . . . . .18
Detail information about power objects in a
power domain . . . . . . . . . . .19

© Copyright IBM Corp. 2005

10.

11.
12.

13.

Summary information about an individual
power domain . . . . . . . . . .
Detail information about an individual power
object o

Event severities and their meanings

Events that affect the information in Power
Executive e
Abbreviations and acronyms used in Power
Executive documentation .

. 20

.21
.27

.27

. 33



Vi IBM Power Executive Installation and User's Guide



About this user’s guide

This user’s guide provides instructions for using IBM® Power Executive to manage
the power and thermal needs of BladeCenter " systems in the data center. Power
Executive is part of a larger power-management implementation that includes
hardware and firmware components. Power Executive 1.0 is an extension to IBM
Director 5.1.

Who should read this user’s guide

This user’s guide is for system administrators and operators using Power
Executive from IBM Director Console to manage the power and thermal needs of
BladeCenter systems in the datacenter.

Conventions and terminology

These notices are designed to highlight key information:
Note: These notices provide important tips, guidance, or advice.

Important: These notices provide information or advice that might help you avoid
inconvenient or difficult situations.

Attention: These notices indicate possible damage to programs, devices, or data.
An attention notice appears before the instruction or situation in which damage
can occur.

Related information

This topic provides links to additional information related to Power Executive.
Power Executive resources on the World Wide Web
The following Web pages provide resources for understanding, using, and

troubleshooting Power Executive and other systems-management tools.

Power Executive Web site
www.ibm.com/servers/eserver/xseries/systems_management/
ibm_director/extensions/powerexec.html

Obtain an overview of Power Executive and links to download the
product, release notes, and user’s guide.

IBM personal computing support page
www.ibm.com/pc/support/

Locate support for IBM hardware and systems-management software.

IBM Systems Management Software: Download/Electronic Support page
www.ibm.com/servers/eserver/xseries/systems_management/ibm_director/

Download IBM systems-management software, including Power Executive.
Check this Web page regularly for new Power Executive releases and
updates.

© Copyright IBM Corp. 2005 vii



IBM @server © xSeries® Systems Management page
www.ibm.com/servers/eserver/xseries/systems_management

Obtain an overview of IBM systems management.

IBM ServerProven® page
www.ibm.com/pc/us/compat/index.html

Obtain information about IBM xSeries, IBM @server , IBM BladeCenter, and
IBM IntelliStation® hardware compatibility.

How to send your comments

Your feedback is important in helping to provide the most accurate and highest
quality information. If you have any comments about this book or any other IBM
publication, use the form for reader’s comments that is provided at the back of this
publication. If the form has been removed, address your comments to:

International Business Machines Corporation
Design & Information Development
Department CGFA

PO Box 12195

Research Triangle Park, NC 27709-9990
US.A.

Accessibility

Accessibility features help a user who has a physical disability, such as restricted
mobility or limited vision, to use information technology products successfully.

Features

Power Executive meets the accessibility standards for Section 508 of the US
Rehabilitation Act.

These are the major accessibility features in Power Executive:

* You can use screen-reader software and a digital speech synthesizer to hear what
is displayed on the screen.

* You can operate all features using the keyboard instead of the mouse.

* You can choose from a variety of high-contrast color schemes and large font
sizes in the IBM Director Console.

Power Executive supports all accessibility features provided by IBM Director.
Keyboard navigation

This product uses standard Microsoft® Windows® and Java'" navigation keys.
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Chapter 1. Getting started

This topic contains general and conceptual information about Power Executive.

Introducing Power Executive

This topic provides an overview of Power Executive.

Power Executive is an IBM Director extension that provides the Power Executive
task in an IBM Director environment. The Power Executive task displays the
Power Executive window in IBM Director Console. The Power Executive window
enables you to monitor and collect power consumption data from chassis objects,
manage trend data, and export data from Power Executive.

Power Executive is comprised of three components: Power Executive Server, Power
Executive Console, and the Power Executive database.

Additionally, the information in Power Executive is affected by some events. For
more information, see [“Understanding events that affect Power Executive” on pagé

Power Executive Task Overview

Use Power Executive to monitor and collect power consumption data from
supported BladeCenter chassis objects and power objects, manage trend data, and
export data from Power Executive.

Power Executive is comprised of three components: Power Executive Server, Power
Executive Console, and Power Executive database.

For more information about the Power Executive task, see the IBM Power Executive
Installation and User’s Guide. This document is available from the Power Executive
Web page. See the following table for availability.

Icon [

Supported IBM Level-0 managed systems
Director objects

Supported operating  Linux®
systems * Windows

For detailed operating-system support information, see the Power
Executive documentation.

Availability Extension to the IBM Director product. You can download the
extension from the IBM Support Web site at

http:/ /www.ibm.com/servers/eserver/xseries/
systems_management/ibm_director.

Required hardware or | For installation, none. For monitoring, this task only supports
hardware limitations specific BladeCenter chassis. For details, see the Power Executive
documentation.

Required software BladeCenter Management extension to IBM Director 5.1 must be
installed.

© Copyright IBM Corp. 2005 1



Required protocols None

Required device None
drivers

Mass Configuration No
support

Scheduler support No
Files associated with None
this task

Events associated with |None, but the information displayed by Power Executive is
this task affected by some events. For more information, see the Power
Executive documentation.

Power Executive terminology

Power Executive uses terminology that is specific to power management in IBM
Director Console.

The hardware in a Power Executive environment is referred to in the following

ways:

e A management server is a server on which both IBM Director Server and Power
Executive Server are installed.

* A management console is a system on which both IBM Director Console and
Power Executive Console are installed.

* A managed system is a BladeCenter server that is a level-0 system (agentless) in
an IBM Director environment.

* A module is a BladeCenter component that is inserted in a bay in a chassis.

* A management module is the BladeCenter component that handles
system-management functions. It configures the chassis and switch modules,
communicates with the blade servers and all I/O modules, multiplexes the
keyboard/video/mouse (KVM), and monitors critical information about the
chassis and blade servers.

The software and its components in a Power Executive environment are referred to
in the following ways:

* A chassis object is an IBM Director managed object that represents a BladeCenter
chassis whose power information can be displayed in Power Executive.

* A power object is an IBM Director managed object that represents a module in a
BladeCenter chassis. Power objects can include the following BladeCenter
components:

— power modules

— processor blades

- 1/O modules

— management modules
— blower modules

— media trays

— midplanes
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Power Executive components

This topic provides information about the Power Executive components.

Power Executive is comprised of the following three components:
* Power Executive Server
* Power Executive Console

e Power Executive database

Power Executive Server

Power Executive Server maintains the Power Executive environment and manages
all Power Executive operations.

Power Executive Server communicates out-of-band with each managed system and
Power Executive Console to display status and perform operations. Power
Executive Server communicates with IBM Director Server to provide event filtering
and event actions that support IBM Director event action plans. Power Executive
Server must be installed on the management server. When you install Power
Executive Server, Power Executive Console is installed automatically.

Power Executive Server communicates indirectly with management modules by
querying IBM Director Server for information that IBM Director has already
collected from the management modules. When IBM Director does not have the
requested information, Power Executive Server can communicate directly with
management modules through an internal communication path.

Power data is collected only while the Power Executive Server is running. When
you install Power Executive, the Power Executive Server starts running. It runs
whenever the IBM Director Service is running. Power Executive collects data on
BladeCenter chassis every minute, or as configured on the Manage Trend Data
window.

Power Executive Console

Power Executive Console provides the graphical user interface (GUI) to Power
Executive in IBM Director Console.

Install Power Executive Console on all management consoles from which a system
administrator remotely accesses the management server and performs Power
Executive tasks.

Power Executive database

The Power Executive database stores information collected by Power Executive
Server.

Power Executive creates or updates its database when Power Executive obtains
information that IBM Director cannot provide. The Power Executive database can
contain information about chassis objects, power objects, and historical data, such
as temperature and power data over time.

The Power Executive database is created in the PowerExecutive subdirectory of the
IBM Director installation directory.
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When you uninstall IBM Director Server, it does not remove the Power Executive
database unless you request that customizations should be deleted during the
uninstallation of IBM Director Server.

The size of the Power Executive database directly correlates to the short-term
polling interval, the long-term polling interval, and the number of days that
short-term and long-term trend data is kept. All of these values are configurable.
You can control them and the size of the Power Executive database by using the
Manage Trend Data window. For information about doing so, see

lcollection of trend data” on page 24.|

Further, the Power Executive database can grow very large when you are retaining
data about blade servers that have enabled the power meter.

As an example, you could have one chassis fully populated with 14 blade servers,
each that have enabled the power meter. Assuming that the short-term polling
cycle is the default value of 1 minute and the long-term polling cycle is the default
value of 10 minutes, then a day’s worth of short-term data consumes
approximately 1 1/4 MB of database storage. In this scenario, one day’s worth of
long-term polling data consumes approximately 126 KB of database storage.

When the Power Executive database cannot expand, Power Executive deletes the
oldest historical data from the database to free up room for the new data that it is
collecting.

Power Executive task

4

The Power Executive task runs the Power Executive graphical-user interface from
an IBM Director Console. You can use the Power Executive task to view and
monitor power consumption on various chassis objects and power objects in the
IBM Director environment.

When you add Power Executive Console to your IBM Director environment, the
Power Executive task is added to IBM Director Console. The Power Executive task
does not have any subtasks. The Power Executive task can be started in various
ways: from the Console menu, from the Tasks menu, from the toolbar, by dragging
the Power Executive task from the Tasks pane onto a managed system or a
managed group, or by dragging a managed system or managed group onto the
Power Executive task in the Tasks pane. The Power Executive task can be started
for all chassis objects that are known to IBM Director Server, or it can be started
for only specific chassis objects.

From the Power Executive interface, you can perform the following tasks for
chassis objects and power objects:

* Monitor power consumption data
* Collect power consumption data
* Manage trend data

* Export data

More information about these tasks is provided in [Chapter 3, “Using Power]
[Executive,” on page 15)
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Starting Power Executive for all chassis objects

When you start Power Executive for all chassis objects in the IBM Director group
called All Systems, the Power Executive window opens and displays a tree of all
chassis objects on IBM Director Server.

When there are numerous chassis objects on the management server, this method
can take several minutes for Power Executive to start. However, the advantage of
starting Power Executive in this manner is that all chassis objects can be managed
from one window.

Starting Power Executive for some chassis objects

When you start Power Executive for only a chassis object or a group of chassis, the
Power Executive window opens and displays a tree of only the selected objects.

The left pane in Power Executive contains only the selected chassis objects, only
those chassis that contain the blade servers that have also been selected, and only
the chassis objects in a selected group. When you select a blade server, Power
Executive determines the containing chassis object and displays the entire tree
structure for that chassis object, not just the blade server that you selected.

The advantage of starting Power Executive in this manner is that Power Executive
must obtain information about only a subset of chassis objects instead of obtaining
information about all chassis objects on IBM Director Server. Power Executive
starts quickly when you use this method. The disadvantage is that you can
manage only those chassis objects that were selected when you started Power
Executive. If you need to manage power objects in other chassis objects or at a
later time, you must start another Power Executive task for those additional chassis
objects.

Power Executive window

After you start the Power Executive task, the Power Executive window opens and
provides a graphical user interface for managing selected chassis objects and
power objects on the management server.

The Power Executive window contains a menu bar, a tool bar, and a graphical
representation of the chassis object selected and power consumption data on
various power objects in these chassis objects. The Power Executive window
displays only those power objects in the chassis objects for which it was started,
which might not be all power objects on the management server.

The Power Executive window contains these major areas:
* Navigation pane

* Detail pane

* Trend pane

You can customize which of these panes are displayed in the Power Executive
window. To do so, see [‘Customizing the Power Executive window” on page 8|

Regardless of the panes that are displayed in the Power Executive window, you
can use the breadcrumb at the upper right of the window to determine the tree
structure of the object that is currently selected. You can also navigate back up the
tree structure to see information about higher-level objects. This is equivalent to
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6

collapsing the tree structure in the navigation pane or selecting a higher-level tree
element. To expand the tree structure, you must use the navigation pane.

You can force the window to refresh in different ways, as explained in
fthe Power Executive window” on page 9.

Navigation pane

Use the navigation pane to select the power object for which the Power Executive
window displays information.

The left side of the window contains the navigation pane, which contains a tree
structure that can be expanded and collapsed. The contents of the tree structure
vary based on the method used to start Power Executive:

 If Power Executive is started by double-clicking the Power Executive task, then
the navigation pane displays all chassis objects that are known to IBM Director.
The root of the tree structure is the IBM Director group All Systems.

 If Power Executive is started by targeting a group of chassis, then the navigation
pane displays all chassis objects in that group. The root of the tree structure is
the group that you targeted.

* If Power Executive is started by targeting a single blade server or chassis, then
the navigation pane displays only the selected chassis object or chassis object
that contains the targeted blade server. The root of the tree structure is the
chassis object itself.

When you expand an individual chassis object within the navigation pane, the tree
structure shows folders that identify the power domains in the chassis. Under each
power domain folder are various power objects within that power domain, such as
the following objects:

* power modules

* blade servers

¢ I/0 modules

* management modules

* blower modules

e media trays

* midplanes

Note: The Power Executive window uses the term module to refer to a
BladeCenter component that is inserted in a bay. Generally an entire
BladeCenter component is inserted into one bay so this distinction is
unnecessary. However, some blade servers span multiple bays and those
bays can be in different power domains. In this scenario, it is important to
remember that Power Executive is displaying power information per each
bay and not per each BladeCenter component.

When you select one of these power objects, Power Executive updates the object
information pane and the trend pane to display information about the power
object that you selected.

Detail pane

Use the detail pane to view information about a selected power object.

The upper right side of the window contains the detail pane, which use a table to
display information about the chassis object or power object that is currently
selected in the tree structure.
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The rows and columns in the table change with the chassis object or power object
that is selected.

* If you select the root of the tree in the navigation pane and it represents an IBM
Director group, the detail pane displays rows about the chassis objects in that
group and columns with information about that chassis object.

* If you select a chassis in the navigation pane, the detail pane displays rows
about the power domains in the chassis and columns with information about
those power domains.

* If you select a power domain in the navigation pane, the detail pane displays
rows about the power objects in that power domain and columns with
information about those power objects.

* If you select a power object within a power domain in the navigation pane, the
detail pane displays information about the fields and field values for that power
object.

For information about the columns and fields in the tables of the details pane, see
[“Monitoring power consumption data” on page 15)

Power Executive updates the information in the detail pane when new information
becomes available, which is generally once per polling interval. The default is
every minute, but this polling interval can be customized. For more information,
see [“Managing collection of trend data” on page 24

You can use Power Executive to export the information in the detail pane. For
more information, see either [“Exporting a trend table” on page 26| or [“Exporting 4|
ftrend graph” on page 26

When the detail pane is displaying group, chassis, or power domain information,
the last row of the table provides a summary of the other information in the table.
Just the summary information in the detail pane can be exported by Power
Executive. For more information, see [“Exporting summary data” on page 25/

Trend pane

Use the trend pane to view information about current and historical power
consumption for a selected power object.

The lower right side of the window contains the trend pane, which provides a
power meter and either a tabular or a graphical view of power data over time
about the power object that is currently selected in the tree structure.

The watts shown in the power meter can represent alternating current (ac) or
direct current (dc) watts as follows:

* When the power meter is displayed for a power object, the watts in the power
meter represent dc watts.

* When the power meter is displayed for a group of chassis, an individual chassis,
or a group, the watts in the power meter represent ac watts.

The title for the power meter changes to represent the type of watts being
measured.

The time range for the displayed trend data is indicated by the trend data interval
drop-down list box. You can select one of the predefined data ranges or create a
custom trend data interval. For more information, see [“Creating a custom timel
finterval for the trend pane” on page 24
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The predefined data ranges are as follows:
e Last hour

e Last 12 hours

e Last 24 hours

* Last 48 hours

* Last week

* Last 2 weeks

¢ Last month

e Last 6 months

* Last year

The check boxes above the trend data table or trend data graph enable you to
control the display of power in use, minimum and maximum power in use, and
event information. The values for each of these graphs is displayed in the trend
data graph in a different color. For the trend data table, this information is put into
cells of the table.

Table 1. Colors and meanings that are used in trend graph

Graph Check | Displayed in trend graph
boxes as Description

Power in Use |Green line Shows the power-in-use as reported by the
BladeCenter management module.

Min and Max | Minimum power is shown |Shows the minimum power that the object
Power in Use |as a blue line while has consumed and the maximum power that
maximum power is shown |the object has consumed.

as a red line

Events Green triangles and yellow |Shows the Power Executive events that have
diamonds occurred. Each event has a severity. For more
information, see [“Events reported on the]
|trend pane” on page 2§

If the Power in Use and Min and Max Power check boxes are selected for display
and all three power values are the same, the combined line is red.

On the trend data graph, you can also select a time range graphically by using the
mouse to zoom in or out on the current view.

Customizing the Power Executive window

You can customize the contents of the Power Executive window.

You can control the display of these panes on the Power Executive window:
* Navigation pane

* Detail pane

e Trend pane

To show or hide one of these panes, use the View menu to check or uncheck the
name of each pane.

When the trend pane is displayed, you can control its display as follows:
* Show or hide the power meter

* Show the trend data as a graph

¢ Show the trend data as a table

8 IBM Power Executive Installation and User's Guide



To control these aspects of the trend pane, use the View menu to check or uncheck
each aspect you wish to control.

Refreshing the Power Executive window

You can use the Refresh function to request an update of the information that is
shown in the Power Executive window.

Power Executive obtains its information from persistent storage in IBM Director
Server and then caches the information on the console for subsequent display in
Power Executive. See |[“Monitoring power consumption data” on page 15 for the
types of information that is displayed by Power Executive.

By default, the window view is refreshed automatically once per short-term polling
interval. The default is every minute, but this polling interval can be customized.
To configure the short-term polling interval, see [“Managing collection of trend]
[data” on page 24

Additionally, certain events from Server Configuration Manager also cause
refreshes. For more information, see [“Events that cause refresh operations” on page|

The Configuration Manager Editor allows you to create and edit profiles that
include configuration settings for the components of BladeCenter® Chassis, such as
switches and management modules.

However, with the Refresh function, you can force a refresh request rather than
waiting for the polling interval or an event to occur.

To refresh the Power Executive window, click the Refresh icon in the toolbar. If the
management server contains several power objects that are being displayed in
Power Executive, the refresh operation can take several minutes. Alternatively, you
can use the View » Refresh menu option.

During the refresh operation, the status line of the Power Executive window
displays the word Refreshing to indicate that the operation is active. After the
refresh operation is complete, the status line displays the word Ready.

Invoking Power Executive functions

Operations are invoked in Power Executive primarily through the toolbar or the
menu bar at the top of the Power Executive window.

You can use the menu bar to suspend and resume data collection, manage trend
data, export power information, derate power for individual power objects,
customize the contents of the Power Executive window, access the Power
Executive help system, and close the Power Executive window. Menu bar
operations are explained in |Chapter 3, “Using Power Executive,” on page 15/

The Power Executive toolbar contains the functions that are described in [Table 2

Table 2. Toolbar icons and their actions

Icon Action

&l Hides the Power Meter in the trend pane. This icon is available only when
the Power Meter is displayed in the trend pane.

Chapter 1. Getting started 9



10

Table 2. Toolbar icons and their actions (continued)

Icon Action
= Displays the Power Meter in the trend pane. This icon is available only
when the Power Meter is not displayed in the trend pane.
Displays trend data in graphical format. This toolbar icon is available only
when the trend data is displayed in tabular format.
Displays trend data in tabular format. This toolbar icon is available only

when the trend data is displayed in graphical format.

Refreshes the entire tree structure in the navigation pane and updates the
power information in the detail and trend panes.

Suspend data collections. This toolbar icon is available only for chassis
objects whose data is actively being collected by Power Executive.

Bl =2 @

Resume data collections. This toolbar icon is available only for chassis
objects whose data collection has been suspended by Power Executive.
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Chapter 2. Installing Power Executive

This chapter provides information about requirements, planning, and preparation,
as well as instructions for installing and uninstalling Power Executive.

Requirements

This topic provides information about Power Executive product requirements.

In addition to the requirements that are applicable to IBM Director 5.1, Power
Executive has further restrictions regarding the hardware and software with which
it can be used. For information about IBM Director 5.1 requirements, see the IBM
Director Installation and Configuration Guide.

Hardware requirements

This section describes the minimum hardware requirements that must be met
when you install or use Power Executive

Management servers and management consoles
Power Executive can be installed on any management server or management
console that supports IBM Director 5.1.

Managed systems
Power Executive can monitor the power objects in certain BladeCenter servers that
are IBM Director level-0 managed systems:

Specifically, Power Executive can monitor these BladeCenter chassis:
* BladeCenter machine type 8677
* BladeCenter T, machine types 8720 and 8730

Within a supported BladeCenter chassis, Power Executive can provide actual
power consumption information for the BladeCenter HS20, machine type 8843,
because that blade server can enable the power meter function.

Within a supported BladeCenter chassis, Power Executive can provide estimates of
power consumption for these blade servers that do not have power-metering
support:

* BladeCenter HS20, machine type 8678
* BladeCenter HS20, machine type 8832
* BladeCenter JS20, machine type 8842

* BladeCenter LS20, machine type 8850

Supported operating systems

Power Executive is supported for use with IBM Director 5.1 management servers
and management consoles that are running supported 32-bit operating systems.

Power Executive supports a subset of the operating systems supported by IBM
Director. Specifically, these operating systems are supported for Power Executive
Server and Power Executive:

* Red Hat Enterprise Linux AS and ES, version 4.0, for Intel® x86

© Copyright IBM Corp. 2005 11



e SUSE LINUX Enterprise Server 9 for x86
* Windows Server 2003, Enterprise, Standard, and Web Editions

Preparing to install Power Executive

Use this section to ensure that your environment is set up properly for the
installation and use of Power Executive.

Checking all prerequisites

Ensure that all prerequisites have been met before you install and use Power
Executive.

The following prerequisites are specific to Power Executive v1.0:
* IBM Director 5.1 is installed

* BladeCenter Management extension of IBM Director is installed

Downloading Power Executive

Use this section to ensure that your environment is set up properly for the
installation and use of Power Executive.

Complete the following steps to download Power Executive from the IBM Web
site:

1. Go to the overview page for Power Executive. This page is located at
www.ibm.com/servers/eserver/xseries/systems_management/ibm_director/
extensions/powerexec.html

2. On the right side of the overview page, click the link for the download page.

3. From the download page, click the file link for the executable file that you
want to download.

lists the executable files that you can download.

Table 3. Power Executive files that can be downloaded

Operating |Power Executive
system Component File to download

Windows Server or console |40k1484.exe

Linux Server PowerExecutive-server-1.0-1.noarch.rpm

Linux Console PowerExecutive-console-1.0-1.noarch.rpm

You should also download the IBM Power Executive 1.0 Release Notes and the
IBM Power Executive Installation and User’s Guide from this Web page.

4. Copy the downloaded file to a local drive on each management server and
management console on which you want to install Power Executive. Be sure
that you copy the correct file based on the operating system that the
management server or management console is using.

Installing Power Executive on systems running Windows

This section provides instructions for installing Power Executive on systems that
are running Windows..

If you are installing Power Executive on systems that are running Linux, see
[“Installing Power Executive on systems running Linux” on page 13,
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Complete the following steps to install Power Executive on a system that is
running Windows:

1. If IBM Director Server or IBM Director Console is running, close them.

2. From the system on which you want to install Power Executive, run the
executable file that you downloaded.

Note: The operating-system account that is used to install Power Executive
must have at least local Administrator authority.

The Power Executive Setup program starts. After several seconds, the welcome
window opens.

3. Click Next. The License Agreement window opens.

4. Read the license agreement, click I accept the terms in the license agreement,
and click Next. The Ready to Install the Program window opens.

5. Click Install.

* If you are installing Power Executive Server and IBM Director Server is
running, then a notification window opens that describes that the IBM
Director service must be stopped during the installation of Power Executive.
After the Power Executive installation is completed, the IBM Director service
is restarted. Click Next to continue the installation. The Installing IBM Power
Executive window opens. The progress of the installation is displayed.

* If you are installing Power Executive Console or Power Executive Server
when IBM Director Server is not running, the Installing IBM Power Executive
window opens. The progress of the installation is displayed.

When the installation is completed, the InstallShield Wizard Completed

window opens.

6. Click Finish.

Installing Power Executive on systems running Linux

This section provides instructions for installing Power Executive on systems that
are running Linux.

If you are installing Power Executive on systems that are running Windows, see
[“Installing Power Executive on systems running Windows” on page 12

Complete the following steps to install Power Executive on a system that is
running Linux:

Note: If you are installing Power Executive Server and IBM Director Server is
running, then this installation stops the IBM Director service before the
Power Executive installation begins. After the Power Executive installation is
completed, the IBM Director service is restarted.

1. From the system on which you want to install Power Executive, stop the IBM
Director Service by entering the following command at the command prompt:

twgstop
2. Run the executable file that you downloaded:

* On systems where you are installing Power Executive Server, enter the
following command at the command prompt:

rpm -iv PowerExecutive-server-1.0-1.noarch.rpm

* On systems where you are installing Power Executive Console, enter the
following command at the command prompt:

rpm -iv PowerExecutive-console-1.0-1.noarch.rpm
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3.

Note: The operating-system account that is used to install Power Executive
must have at least local Administrator authority.

After Power Executive is installed, start the IBM Director Service:
twgstart

Uninstalling Power Executive on systems running Windows

This section provides instructions for uninstalling Power Executive on systems that
are running Windows..

If you are uninstalling Power Executive on systems that are running Windows, see

[“Uninstalling Power Executive on systems running Windows.”|

Complete the following steps to uninstall Power Executive on systems that are
running Windows:

1.
2.

4.

Click Start > Settings > Control Panel. The Control Panel window opens.

Double-click Add/Remove Programs. The Add/Remove Programs window
opens.

Click the currently installed program IBM Power Executive ; then click
Change/Remove.

Follow any further instructions on the screen.

Uninstalling Power Executive on systems running Linux

14

This section provides instructions for uninstalling Power Executive on systems that
are running Linux.

If you are uninstalling Power Executive from systems that are running Windows,
sed”Uninstalling Power Executive on systems running Windows.”]

Complete the following steps to uninstall Power Executive from a Linux system:

1.

From the system on which you want to uninstall Power Executive, stop the
IBM Director Service by entering the following command at the command
prompt:
twgstop
Run the uninstallation program by entering one of the following commands:

* On systems where you are uninstalling Power Executive Server, enter the
following command at the command prompt:

rpm -ev PowerExecutive-server

* On systems where you are uninstalling Power Executive Console, enter the
following command at the command prompt:

rpm -ev PowerExecutive-console

After Power Executive is uninstalled, start the IBM Director Service by entering
the following command:

twgstart
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Chapter 3. Using Power Executive

This chapter provides information about using Power Executive to monitor and
collect power consumption data, manage trend data, and export data from Power
Executive.

Monitoring power consumption data

Use Power Executive to display details and summaries about chassis objects and
power objects.

You can display the following details and summaries:
* For a group of chassis, you can display details and summary information.
 For an individual chassis, you can display details and summary information.

* For an individual power domain, you can display details and summary
information

* For an individual power object, you can display details

Displaying details about a group of chassis

This section describes the details that Power Executive provides about a group of
chassis objects.

Complete the following steps to display details about a group of chassis objects:

1. From IBM Director Console, drag the Power Executive task onto a group of
chassis objects.

2. In the navigation pane of the Power Executive window, look at the information
in the detail pane.

Each row in the table corresponds to one chassis object in the group. All power
numbers in the table represent alternating current (ac) power.

The last row of the table summarizes information about the chassis objects in the
group. For more information, see ['Displaying summary information about a group|
fof chassis” on page 16.|

describes the information that is displayed for each chassis in the group.

Table 4. Detail information about a group of chassis

Column title Description

Name The name of the chassis object.

Power Collection | The status of data collection. Values are Enabled, Disabled, and
Offline.

The offline status is used when data collection is enabled, but the
BladeCenter management module is not responsive. The offline status
reflects only whether the BladeCenter management module is
responsive to Power Executive. It is not an indicator of system health.
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Table 4. Detail information about a group of chassis (continued)

Column title

Description

Power in Use
(Watts)

The sum of the power in use by all power domains in the chassis. This
value is measured in watts.

If no value is displayed, then data to determine this value is
unavailable.

Static Max Power
as Configured
(Watts)

The sum of the static maximum power of all power domains in the
chassis. This value is measured in watts. The static maximum power is
the nameplate power as reported by vital product data (VPD).

Ambient
Temperature
(Celsius)

The current ambient (inlet) temperature of the chassis. This value is
measured in Celsius degrees.

Acoustic Mode

Whether acoustic mode is in use for the chassis. Values are Enabled or
Disabled. For information about acoustic mode, see the documentation
that comes with the BladeCenter management module that is in the
affected chassis.

Thermal Load
(BTU/hr)

An estimate, based on the power in use, of the thermal load placed on
the surrounding environment by this chassis.

The following formula is used to determine the estimate that is
displayed:

1 watt = 3,412 BTU/hour

Displaying summary information about a group of chassis

This section describes the summary information that Power Executive provides
about a group of chassis objects.

Complete the following steps to display summary information about a group of
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chassis objects:

1. From IBM Director Console, drag the Power Executive task onto a group of

chassis objects.

2. In the navigation pane of the Power Executive window, look at the summary
information in the last row of the detail pane.

describes the summary information that is displayed about a group of
chassis objects. All power numbers in the summary row represent alternating
current (ac) power.

Table 5. Summary information about a group of chassis

Column title

Description

Name

The name of the group that is summarized.

Power Collection

Not used.

Power in Use
(Watts)

The sum of the power in use of all chassis in the group. This value is
measured in watts.

If no value is displayed, then data to determine this value is
unavailable.

Static Max Power
as Configured
(Watts)

The sum of the static maximum power of all chassis in the group. This
value is measured in watts. The static maximum power is the
nameplate power as reported by vital product data (VPD).
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Table 5. Summary information about a group of chassis (continued)

Column title Description
Ambient Not used.
Temperature

(Celsius)

Acoustic Mode Not used.

Thermal Load
(BTU/hr)

The sum of the thermal load of all chassis in the group. This value is
measured in British thermal units (Btus) per hour.

If no value is displayed, then data to determine this value is
unavailable.

Displaying details about an individual chassis

This section describes the details that Power Executive provides about an
individual chassis object.

Complete the following steps to display details about an individual chassis object:

1. From IBM Director Console, drag the Power Executive task onto a chassis

object.

2. In the navigation pane of the Power Executive window, look at the information
in the detail pane.

Each row in the table corresponds to one power domain in the chassis. All power
numbers in the table represent alternating current (ac) power.

The last row of the table summarizes information about the power domains in the
chassis. For more information, see [“Displaying summary information about an|

lindividual chassis” on page 18

describes the information that is displayed for each power domain in a

chassis.

Table 6. Detail information about an individual chassis

Column title

Description

Name

The name of the power domain.

Power in Use

The sum of the power in use by all power objects in the power domain.

(Watts) This value is measured in watts.
If no value is displayed, then data to determine this value is
unavailable.
Static Max The sum of the static maximum power of all power domains in the
Power as chassis. This value is measured in watts. The static maximum power is
Configured the nameplate power as reported by vital product data (VPD).
(Watts)
Redundancy The redundancy in the power domain. Values are one of the following:
Status ¢ Redundant Power Available

* Non-Redundant Power Available
* No Power Available

For information about power management policy settings, including
redundancy in the power domain, see the documentation that comes
with the BladeCenter management module that is in the affected chassis.
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Table 6. Detail information about an individual chassis (continued)

Column title Description

Oversubscription | The oversubscription policy that is in use by the chassis. Values are one
Policy of the following;:

* Redundant without Performance Impact

* Redundant with Performance Impact

* Non-Redundant

For information about oversubscription policies, see the documentation
that comes with the BladeCenter management module that is in the
affected chassis.

Displaying summary information about an individual chassis

This section describes the summary information that Power Executive provides
about an individual chassis.

Complete the following steps to display summary information about an individual

chassis:

1. From IBM Director Console, drag the Power Executive task onto a chassis
object.

2. In the navigation pane of the Power Executive window, look at the summary
information in the last row of the detail pane.

describes the summary information that is displayed about an individual
chassis. All power numbers in the summary row represent alternating current (ac)
power.

Table 7. Summary information about an individual chassis

Column title Description

Name The name of the chassis that is summarized.

Power in Use The sum of the power in use by all power domains in the chassis. This
(Watts) value is measured in watts.

If no value is displayed, then data to determine this value is

unavailable.
Static Max The sum of the static maximum power of all power domains in the
Power as chassis. This value is measured in watts. The static maximum power is
Configured the nameplate power as reported by vital product data (VPD).
(Watts)
Redundancy Not used.
Status

Oversubscription | Not used.
Policy

Displaying details about individual power domains

This section describes the details that Power Executive provides about an
individual power domain within a chassis.

Complete the following steps to display details about an individual power domain:

1. From IBM Director Console, drag the Power Executive task onto the chassis
that contains the power domain.
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2. In the navigation pane of the Power Executive window, expand the tree
structure until you see the power domain.

3. Click the name of the power domain.

4. Look at the information about the power domain in the detail pane.

Each row in the table corresponds to one bay, which is generally one power object,
within the power domain. The power numbers for modules in the table represent
direct current (dc) power.

The last row of the table summarizes information about the power objects in the
power domain. The power numbers in the summary row represent alternating
current (ac) power. For more information, see [‘Displaying summary information|

labout individual power domains” on page 20.

describes the information that is displayed for each power object in a

power domain.

Table 8. Detail information about power objects in a power domain

Column title

Description

Name

The name of the power object.

Type

The type of power object. Values are one of the following:

* Power Module
Note: The power consumption listed for the power module represents
the amount of power lost in the power module.

* Blade Server

* I/O Module

* Management Module

* Blower Module

* Media Tray

* Midplane

Bay

The number of the bays that this power object occupies.

Power Meter
Supported

(blade servers only) Whether a power meter is enabled on this processor.
Values are Yes and No.

Power in Use

The power-in-use of the power object.

(Watts) * For a blade server that has enabled the power meter, this column
displays the actual watts being consumed as reported by the power
meter.

If no value is displayed, then data to determine this value is
unavailable.

* For all other blade servers and all power objects, this column displays
the same value as that displayed by the Static Max Power as Configured
column, reduced by the derating percentage. For more information, see
[‘Setting the derating power factor” on page 22|

In both cases, this value is measured in watts.

Static Max The nameplate power as reported by vital product data (VPD).

Power as

Configured

(Watts)
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Table 8. Detail information about power objects in a power domain (continued)

Column title

Description

Max Power in
Use (Watts)

The maximum watts consumed during the current measurement interval.

* For a blade that has enabled the power meter, this column displays the
value as reported by the power meter.

If no value is displayed, then data to determine this value is
unavailable.

* For all other blades and all power objects, this column displays the
same value as that displayed by the Static Max Power as Configured
column.

In both cases, this value is measured in watts.

Max Power in
Use Time

(Blade servers that have enabled the power meter only) The time at which
the maximum power value was recorded.

If no value is displayed, then data to determine this value is unavailable.

Displaying summary information about individual power
domains

This section describes the summary information that Power Executive provides
about an individual power domain.

Complete the following steps to display summary information about an individual
power domain:

1. From IBM Director Console, drag the Power Executive task onto the chassis
object that contains the power domain.

2. In the navigation pane of the Power Executive window, expand the tree
structure until you see the power domain.

3. Click the name of the power domain.

4. Look at the summary information about the power domain in the last row of
the detail pane.

describes the summary information that is displayed about an individual
power domain. The power numbers in the summary row represent alternating
current (ac) power.

Table 9. Summary information about an individual power domain

Supported

Column title |Description

Name The name of the power domain that is summarized.
Type Not used.

Bay Not used.

Power Meter |Not used.

Power in Use

The sum of the power-in-use of all power objects in the power domain.

(Watts) This value is measured in watts.

If no value is displayed, then data to determine this value is unavailable.
Static Max The sum of the static maximum power of all power objects in the power
Power as domain. This value is measured in watts. The static maximum power is the
Configured nameplate power as reported by vital product data (VPD).
(Watts)
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Table 9. Summary information about an individual power domain (continued)

Column title |Description

Max Power in | Not used.
Use (Watts)

Max Power in | Not used.
Use Time

Displaying details about individual power objects

This section describes the details that Power Executive provides about individual
power objects.

Complete the following steps to display details about an individual power object:

1. From IBM Director Console, drag the Power Executive task onto the chassis
object that contains the power object.

2. In the navigation pane of the Power Executive window, expand the tree
structure until you see the power object.

3. Click the name of the power object.
4. Look at the information about the power object in the detail pane.

Each row in the table corresponds to one power object in the chassis.

describes the information that is displayed for an individual power object.
The power numbers in the table represent direct current (dc) power.

Table 10. Detail information about an individual power object

Field Name Description

Name The name of the power object. No value is displayed when the bay
is not populated.

Type The type of power object. Values are one of the following:

* Power Module
Note: The power consumption listed for the power module
represents the amount of power lost in the power module.

* Blade Server

* 1/0 Module

* Management Module

* Blower Module

* Media Tray

* Midplane

Bay The number of the bay that this power object occupies.

Power Meter Whether a power meter is enabled on this processor. For a blade

Supported server, values are Yes and No. For any other power object, the
value is always No. No value is displayed when the bay is not
populated.
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Table 10. Detail information about an individual power object (continued)

Field Name

Description

Power in Use (Watts)

The power-in-use of the power object.

* For a blade server that has enabled the power meter, this
column displays the actual watts being consumed as reported
by the power meter.

If no value is displayed, then data to determine this value is
unavailable.

¢ For all other blade servers and all power objects, this column
displays the same value as that displayed by the Label Power
column, reduced by the derating percentage.

In both cases, this value is measured in watts.

Static Max Power as
Configured (Watts)

The nameplate power as reported by Vital Product Data (VPD).

Derate Static Max
Power to (Percent)

The percentage of the static maximum power to use when
estimating the power-in-use for blade servers that have not
enabled the power meter and for all other power objects. The
default value is 100% which means that the static maximum power
is not reduced when used as an estimate for the power-in-use.

Max Power in Use
(Watts)

The maximum watts consumed during the current measurement
interval.

* For a blade server that has enabled the power meter, this
column displays the value as reported by the power meter.

If no value is displayed, then data to determine this value is
unavailable.

* For all other blade servers and all power objects, this column
displays the same value as that displayed by the Label Power
column.

In both cases, this value is measured in watts.

Max Power in Use
Time

(Blade servers that have enabled the power meter only) The time
at which the maximum power value was recorded.

If no value is displayed, then data to determine this value is
unavailable.

Current CPU Throttle
Values (Percent)

(Blade server only) A comma-separated list of the current throttle
values of each CPU in the blade server. A value of 100% indicates
that a CPU is running at maximum performance (full throttle). For
information about throttle levels, see the documentation that
comes with the BladeCenter management module that is in the
affected chassis.

Preset Blade Throttle
Value (Watts)

(Blade server only) The preset throttle level of the chassis that
contains this power object. For information about throttle levels,
see the documentation that comes with the BladeCenter
management module that is in the affected chassis.

Setting the derating power factor

You can set the derating power factor for an individual power object. By default,
the derating power factor is 100 percent, which means that the reported power is

not derated at all.

The derating factor is the percentage of the static maximum power that is used
when estimating the power-in-use for blade servers that have not enabled the
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power meter and for all other power objects. The derating factor does not apply to
power objects when information about the actual power consumed is available
from the BladeCenter management module.

Complete these steps to set the derating factor:
1. From IBM Director Console, start Power Executive.

2. In the navigation pane of the Power Executive window, select the power object
that you want to derate. You cannot derate power for a chassis or a power
domain, you must select a lower-level power object.

3. From the Power Executive window, click Edit » Derate Power. The Power
Executive Derate Power Factor window opens.

4. From the Power Executive Derate Power Factor window, enter a number that
represents the percent of the static maximum power that you want to use when
estimating the power consumption of the power object.

5. Click OK.

Collecting power consumption data

This section provides information about using Power Executive to collect power
consumption data.

By default, power information is collected for all chassis objects that are displayed
in Power Executive.

Suspending data collection

You can suspend data collection on any chassis displayed in Power Executive.

You might decide to suspend data collection to decrease the amount of disk space
required in the Power Executive database. Another reason might be to reduce the
network load from polling for new information about power objects within a
chassis.

Data collection cannot be suspended for individual power objects within a chassis.

Complete these steps to suspend data collection for a chassis:
1. From IBM Director Console, start Power Executive.

2. In the navigation pane of the Power Executive window, select the chassis for
which you want to suspend data collection.

3. From the Power Executive window, click Edit »+ Suspend Data Collection.

Resuming data collection

You can resume data collection for a chassis displayed in Power Executive in
which data collection was previously suspended.

Resuming data collection increases the amount of disk space required in the Power
Executive database. It also increases the network load as it polls for new
information about the power objects within the chassis.

Complete these steps to resume data collection for a chassis:
1. From IBM Director Console, start Power Executive.

2. In the navigation pane of the Power Executive window, select the chassis for
which you want to resume data collection.
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3. From the Power Executive window, click Edit ®» Resume Data Collection.

Managing trend data

This section provides information about using Power Executive to manage trend
data.

Trend data is displayed in the trend pane of the Power Executive window. For
more information, see|“Trend pane” on page 7|

Managing collection of trend data

Trend data can be managed using the Edit menu of Power Executive.

Historical trend data is written to the Power Executive database. You can control
how often and how much historical trend data is written to the database and when
trend data is deleted from the database.

However, when the Power Executive database cannot expand, Power Executive
deletes the oldest historical data from the database to free up room for new data
that it is collecting.

Complete these steps to affect the trend data written to the Power Executive
database:

1. From IBM Director Console, start Power Executive.

2. From the Power Executive window, click Edit » Manage Trend Data. The
Manage Trend Data window opens.

3. Complete the fields on the Manage Trend Data window as follows:

* In the Short-term polling interval in minutes field, enter the number of
minutes in the short-term polling cycle. The default value is one day.

Once every short-term polling interval, Power Executive collects temperature
and power data from the systems under its control. Each short-term polling
interval, Power Executive checks each bay to see if it is populated or not,
and if it is occupied by a different power object from last time. The data
collected during these cycles is considered to be short-term polling data.
Lower values in this field could impact network performance on the systems
involved.

* In the Long-term polling interval in minutes field, enter the number of
minutes in the long-term polling cycle. The default value is ten days. Power
Executive uses the long-term polling cycle to determine which data is
considered to be long-term data. Long-term data is the trend data that can be
displayed on the trend pane.

* In the Number of days to keep short-term trend data field, enter the
number of days that Power Executive identifies data as short-term data
before considering it to be long-term data. The default value is 31 days.

* In the Number of days to keep long-term trend data field, enter the number
of days that Power Executive keeps long-term data before deleting it. The
default value is 365 days.

4. Click OK.

Creating a custom time interval for the trend pane

You can create a custom time interval for use by the trend pane instead of using
one of the predefined time intervals.
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Complete the following steps to create a custom time interval for the trend pane:

From IBM Director Console, start Power Executive.

From the trend pane in the Power Executive window, click Custom as the trend
data interval. The Power Executive Custom window opens.

Complete the fields on the Power Executive Custom window as follows:

— In the first row of fields, enter the day and time from which the trend data
should start. You need to define the month, day, year, hour, and minute from
which to start displaying trend data.

— In the second row of fields, enter the day and time at which the trend data
should stop. You need to define the month, day, year, hour, and minute at
which to stop displaying trend data.

Click OK.

Exporting data from Power Executive

This section provides information about exporting data from Power Executive.

You can export the following types of data:

Summary data from the details pane
Power meter from the trend pane
Trend graph from the trend pane

¢ Trend table from the trend pane

Exporting summary data

Use the File menu in Power Executive to export summary data from the detail
pane.

Power Executive can save the exported summary data in CSV, XML, or HTML
format.

Complete the following steps to export the summary data in the detail pane:

1.
2.

ook w

From IBM Director Console, start Power Executive.

From the Power Executive window, click File » Export »+ Summary Table. The
Export Summary Table window opens.

Select the directory where you want to export the data.

In the File Name field, type a name for the file.

In the Files of Type field, select the type of file that you want to create.
Click OK.

Exporting the power meter

Use the File menu in Power Executive to export the power meter from the trend
pane.

Power Executive saves the exported power meter in JPEG format.

Complete the following steps to export the power meter:

1.
2.

From IBM Director Console, start Power Executive.

From the Power Executive window, click File » Export + Power Meter. The
Export Power Meter window opens.

Select the directory where you want to export the data.
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4. In the File Name field, type a name for the file.
5. Click OK.

Exporting a trend graph

Use the File menu in Power Executive to export a trend graph from the trend
pane.

Power Executive saves the exported power meter in JPEG format.

Complete the following steps to export the trend graph:
1. From IBM Director Console, start Power Executive.

2. From the Power Executive window, click File » Export » Trend Graph. The
Export Trend Graph window opens.

3. Select the directory where you want to export the data.
4. In the File Name field, type a name for the file.
5. Click OK.

Exporting a trend table

Use the File menu in Power Executive to export a trend table from the trend pane.
Power Executive can save the exported trend table in CSV, XML, or HTML format.

Complete the following steps to export the data in a trend table:
1. From IBM Director Console, start Power Executive.

2. From the Power Executive window, click File » Export » Trend Table. The
Export Trend Table window opens.

Select the directory where you want to export the data.

In the File Name field, type a name for the file.

In the Files of Type field, select the type of file that you want to create.
Click OK.

ook~ w

Understanding events that affect Power Executive

This section provides information about the IBM Director events and Power
Executive events that affect the information that is displayed in Power Executive.

Before using Power Executive, you should use the Management Processor
Configuration subtask of the Server Configuration Manager task (formerly
Management Processor Assistant (MPA)) to configure an alert-forwarding profile
for the chassis that contain the power objects that you plan to monitor. In the
alert-forwarding profile, the connection type must be set to “IBM Director
Comprehensive” and the IP address must be set to the IP address of the
management server that is being used to monitor power consumption with Power
Executive. Further, this management server must be the only server that is
configured and enabled to receive alerts from the BladeCenter chassis that you
plan to target.

If an alert-forwarding profile is not created for a chassis, Power Executive cannot
receive any events for that chassis.

Note: The IBM Director event log might not contain all events that are reported in
Power Executive. Further, the timestamps on events is different between the
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IBM Director event log and the trend pane in Power Executive. The IBM
Director event log records the time that the defect occurred. The Power
Executive events reflect the time that Power Executive detected the event.

Events that cause refresh operations

Some events from Server Configuration Manager (formerly Management Processor
Assistant (MPA)) cause Power Executive to poll for new information and refresh
the Power Executive window as needed. Server Configuration Manager is an IBM
Director task that is used to create or update server configuration profiles, which
include management of service processors in xSeries and Netfinity® servers.

able 11| describes the severities that can be assigned to each event.

Table 11. Event severities and their meanings

Event
severity

Description

Critical

Severe events that signal that the system might not be functioning.

Warning

Serious events that could progress to critical severity.

Harmless

Any event that is not severe or serious. These events are not necessarily errors.

describes the events that can cause refreshes of the information in the

Power Executive window.

Table 12. Events that affect the information in Power Executive

Severity | Category Description
Critical Multiple Both blowers in the system failed.
Blower Failure
Critical Power Failure |A system power supply failed.
Critical Temperature A monitored temperature exceeded its critical threshold value.
(If a critical temperature condition is detected on a blade
server, the blade server is automatically shutdown and
powered-off.)
Critical Multiple I/O | Multiple I/O modules failed or were removed.
Module
Failure

Warning | Single Blower |One blower failed.
Failure

Warning | Temperature | A monitored temperature exceeded its warning threshold
value. (This event does not initiate an automatic system
shutdown.)

Warning | Redundant A redundant module failed or was removed.

Module
Failure

Warning Blade Throttle | A BladeCenter is throttled in order to maintain a power
consumption within certain bounds. A recovery event is also
sent.

Warning | Power A power-management event was detected, such as

Management | mismatched power modules in a power domain, demand
exceeding capacity in a domain, or components not being
allowed to power on due to insufficient power.

Harmless |Power-On A blade server or I/O module was turned on.
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Table 12. Events that affect the information in Power Executive (continued)

Severity | Category Description

Harmless | Power-Off A module in the system was turned off.

Events reported on the trend pane

Power Executive displays information about events that it generates in the trend
pane.

Specifically, Power Executive generates and displays event information with the
following severities:

* These events have a warning severity:
— Stop of Power Executive Server
— Suspend data collection for a chassis
— Offline of a chassis
— Removal of a module from a chassis
— Long-term data deleted from the Power Executive database.
* These events have a harmless severity:
— Start of Power Executive Server
— Resume data collection for a chassis
— Online of a chassis
— Insertion of a module from a chassis
— Addition of a chassis.
— Enable or disable acoustic mode.
— Changes to the oversubscription policy.
— Short-term data coalesced.
Events that are generated by Power Executive are collected with other trend data
and stored in the Power Executive database. These events let you know why

historical data might be missing for one or more chassis.

In the trend graph, these events are displayed as follows:
* Events with a warning severity are shown as yellow diamonds.
* Events with a harmless severity are shown as green triangles.

You can mouse-over each event in the trend graph to obtain a description of the
event that occurred.

In the trend table, these events are displayed in the Event column.
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Chapter 4. Troubleshooting

Use this section to troubleshoot and resolve problems with Power Executive.

Contacting customer support

If you need help, service, or technical assistance or just want more information
about IBM products, you can find a wide variety of sources available from IBM to
assist you. This section contains information about where to go for additional
information about IBM and IBM products, what to do if you experience a problem
with your xSeries or IntelliStation system, and whom to call for service, if it is
necessary.

Before you call

Before you call, make sure that you have taken these steps to try to solve the
problem yourself:

* Check all cables to make sure that they are connected.
¢ Check the power switches to make sure that the system is turned on.

* Use the troubleshooting information in your system documentation, and use the
diagnostic tools that come with your system. Information about diagnostic tools
is in the Hardware Maintenance Manual and Troubleshooting Guide on the IBM
xSeries Documentation CD or in the IntelliStation Hardware Maintenance Manual at
the IBM Support Web site.

* Go to the IBM Support Web site at [www.ibm.com/pc/support/| to check for
technical information, hints, tips, and new device drivers or to submit a request
for information.

You can solve many problems without outside assistance by following the
troubleshooting procedures that IBM provides in the online help or in the
publications that are provided with your system and software. The information
that comes with your system also describes the diagnostic tests that you can
perform. Most xSeries and IntelliStation systems, operating systems, and programs
come with information that contains troubleshooting procedures and explanations
of error messages and error codes. If you suspect a software problem, see the
information for the operating system or program.

Using the documentation

Information about your IBM xSeries or IntelliStation system and preinstalled
software, if any, is available in the documentation that is included with your
system. That documentation includes printed books, online books, readme files,
and help files. See the troubleshooting information in your system documentation
for instructions for using the diagnostic programs. The troubleshooting information
or the diagnostic programs might tell you that you need additional or updated
device drivers or other software. IBM maintains pages on the World Wide Web
where you can get the latest technical information and download device drivers
and updates. To access these pages, go to [www.ibm.com/pc/support/|and follow
the instructions. Also, you can order publications through the IBM Publications
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Ordering System at
fwww.elink.ibmlink.ibm.com /public/applications /publications/cgibin / pbi.cgil

Getting help and information from the World Wide Web

On the World Wide Web, the IBM Web site has up-to-date information about IBM
xSeries and IntelliStation products, services, and support. The address for IBM
xSeries information is www.ibm.com/eserver/xseries/. The address for IBM
IntelliStation information is www.ibm.com/pc/intellistation/.

You can find service information for your IBM products, including supported
options, at www.ibm.com/pc/support/.

Software service and support

Through IBM Support Line, you can get telephone assistance, for a fee, with usage,
configuration, and software problems with xSeries servers, IntelliStation
workstations, and appliances. For information about which products are supported
by Support Line in your country or region, go to
www.ibm.com/services/sl/products/.

For more information about Support Line and other IBM services, go to
www.ibm.com/services/, or go to www.ibm.com/planetwide/ for support
telephone numbers. In the U.S. and Canada, call 1-800-IBM-SERV (1-800-426-7378).
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Appendix. Notices
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
MWO9A /050

5600 Cottle Road
San Jose, CA 95193
US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

Trademarks

The following are trademarks of International Business Machines Corporation in
the United States, other countries, or both:

BladeCenter
IBM
IntelliStation
Netfinity
ServeRAID
ServerProven
xSeries

™

Intel is a registered trademarks of Intel Corporation or its subsidiaries in the
United States and other countries.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United
States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of
others.
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Abbreviations, acronyms, and glossary

Abbreviation and acronym list

This topic lists abbreviations and acronyms used
in the Power Executive documentation.

Table 13. Abbreviations and acronyms used in Power
Executive documentation

Abbreviation or

acronym Definition

ac alternating current

BTU British Thermal Unit

Csv comma-separated value

dc direct current

GUI graphical user interface

HTML hypertext markup language

170 input/output

1P Internet Protocol

MPA Management Processor
Assistant

VPD vital product data

Glossary

This topic provides definitions of terms that are
used in the Power Executive product.

A
ac See alternating current.

alternating current
An electric current that reverses its
direction at regularly recurring intervals.

B

blade server
An IBM BladeCenter server. A
high-throughput, two-way, Intel
Xeon-based server on a card that supports
symmetric multiprocessors {SMP}.

BladeCenter chassis
A BladeCenter unit that acts as an
enclosure. This 7-U modular chassis can
contain up to 14 blade servers. It enables
the individual blade servers to share
resources, such as the management,
switch, power, and blower modules.

© Copyright IBM Corp. 2005

British thermal unit
An English unit of measure for heat
produced in one hour.

BTU  See British thermal unit.

chassis
The metal frame in which various
electronic components are mounted.
dc See direct current.

direct current
An electric current that flows in a single
direction and at a constant voltage.

discovery
The process of finding resources within
an enterprise, including finding the new
location of monitored resources that were
moved.

event An occurrence of significance to a task or
system, such as the completion or failure
of an operation. There are two types of
events: alert and resolution.

event action.
The action that IBM Director takes in
response to a specific event or events

event-action plan.
A user-defined plan that determines how
IBM Director manages certain events. An
event action plan comprises one or more
event filters and one or more customized
event actions.

Event Action Plan wizard.
An IBM Director Console wizard that can
be used to create simple event action
plans.

event filter.
A filter that specifies the event criteria for
an event action plan. Events must meet
the criteria specified in the event filter in
order to be processed by the event action
plan to which the filter is assigned to.
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extension.
See IBM Director extension.

G

group. A logical set of managed objects. Groups
can be dynamic, static, or task-based..

IBM Director Console.
A component of IBM Director software.
When installed on a system, it provides a
graphical user interface (GUI) for
accessing IBM Director Server. IBM
Director Console transfers data to and
from the management server using
TCP/IP.

IBM Director environment
The complex, heterogeneous environment
managed by IBM Director. It includes
systems, BladeCenter chassis, software,
SNMP devices.

IBM Director extension.
A tool that extends the functionality of
IBM Director. Some of the IBM Director
extensions are BladeCenter Management,
Capacity Manager, ServeRAID Manager,
Remote Deployment Manager, and Power
Executive.

IBM Director Server.
The main component of IBM Director
software. When installed on the
management server, it provides basic
functions such as discovery of managed
systems, persistent storage of
configuration and management data, an
inventory database, event listening,
security and authentication, management

console support, and administrative tasks.

L

Level-0 managed system
An IBM or non-IBM server, desktop
computer, workstation, or mobile
computer, that can be managed by IBM
Director but does not have any IBM
Director software installed on it.

M

managed group
A group of systems or objects managed
by IBM Director.
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managed object
An item managed by IBM Director. In
IBM Director Console, a managed object
is represented by an icon that shows its
type (such as chassis, cluster, system, or
scalable system, for example).

managed object ID
A unique identifier for each managed
object. It is the key value used by IBM
Director database tables.

managed system
A system that is being controlled by a
given system management application, for
example, a system managed by IBM
Director.

management console
A system (server, desktop computer,
workstation, or mobile computer) on
which IBM Director Console is installed.

management module
The BladeCenter component that handles
system-management functions. It
configures the chassis and switch
modules, communicates with the blade
servers and all I/O modules, multiplexes
the keyboard/video/mouse (KVM), and
monitors critical information about the
chassis and blade servers.

management server
The server on which IBM Director Server
is installed.

module
A BladeCenter component that is inserted
in a bay in a chassis and whose power
consumption data can be monitored by
Power Executive. Modules include power
modules (power supplies), blade servers,
I/0 modules, BladeCenter management
modules, blower modules, and media
trays.

o)

out-of-band communication
Communication that occurs through a
modem or other asynchronous
connection, for example, service processor
alerts sent through a modem or over a
LAN. In an IBM Director environment,
such communication is independent of
the operating system and interprocess
communication (IPC).



P

power object
An IBM Director managed object that can
be managed by Power Executive. A
power object can be a group, a chassis, a
power domain, or a module.

S

switch module
The BladeCenter component that provides
network connectivity for the BladeCenter
chassis and blade servers. It also provides
interconnectivity between the
management module and blade servers.

system
The computer and its associated devices
and programs.

T

target system
A managed system on which an IBM
Director task is performed.

\')

vital product data (VPD)
Information that uniquely defines the
system, hardware, software, and
microcode elements of a processing
system.

VPD  See vital product data.
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accessibility  viii

keyboard viii

shortcut keys  viii
alert-forwarding profile 26

bay 6
breadcrumb 5

C

chassis
displaying details 17
summary 18
collect
data 23
trend 24
components 3
critical events 27
custom time interval 25

D

data
collection 23
resuming 9, 23
suspending 9, 23
trend data 24
exporting 25
derating power factor 22
detail pane 6
displaying 8
details, displaying 15
chassis 17
summary 18
group of chassis 15
summary 16
power domains 18
summary 20
power objects 21
disability viii
downloading Power Executive 12

E

estimating
power consumption 22
events
refresh operations 27
trend pane 28
export
data 25
power meter 25
summary data 25
trend graph 26
trend table 26
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glossary 33
group of chassis
displaying details 15
summary 16

H

hardware
requirements 11

IBM Web sites vii

installation 11, 12
downloading Power Executive 12
prerequisites 12

K

keyboard  viii

L

legal notices 31

M

Manage Trend Data window 24
Management Processor Assistant 27
module 6

monitoring power consumption 15

N

navigation pane 6
displaying 8

o)

operating system
supported 11

P

polling interval 24

power domains
displaying details 18

summary 20

Power Executive
components of 1
concepts 1
database 3
documentation vii
getting started 1
overview 1
prerequisites 12

Power Executive (continued)
uninstalling
Linux 14
Windows 14
Power Executive Console 3
Power Executive Custom window 25
Power Executive Derate Power Factor
window 22
Power Executive Server 3
Power Executive window 5
customizing 8
detail pane 6
events 27
navigation pane 6
refreshing 9
trend pane 7
power meter 7
displaying 8, 9
exporting 25
power objects
derating 22
displaying details 21
problem solving 29

R

refresh 9
requirements 11
hardware 11
resume
data collection 9, 23

S

Server Configuration Manager events
shortcut keys  viii
solving problems 29
summary data

exporting 25
summary, displaying 15

chassis 18

group of chassis 16

power domains 20
suspend

data collection 9, 23
system events 27

—

toolbar 9
trademarks 32
trend graph 7
displaying 8,9
exporting 26
trend pane 7
custom time interval 25
displaying 8
events 28
predefined time intervals 7
trend table 7
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trend table (continued)
displaying 8, 9
exporting 26

troubleshooting 29

U

uninstalling Power Executive
Linux 14
Windows 14
unstallation 13

W

warning events 27
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